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Abstract (The abstract should not exceed 250 words. It should briefly summarize the essence of the paper and address the following areas without using specific subsection titles.): Objective: Briefly state the problem or issue addressed, in language accessible to a general scientific audience. Technology or Method: Briefly summarize the technological innovation or method used to address the problem. Results: Provide a brief summary of the results and findings. Conclusions: Give brief concluding remarks on your outcomes. Clinical Impact: Comment on the translational aspect of the work presented in the paper and its potential clinical impact. Detailed discussion of these aspects should be provided in the main body of the paper.

 (Note that the organization of the body of the paper is at the authors’ discretion; the only required sections are Introduction, Methods and Procedures, Results, Conclusion, and References. Acknowledgements and Appendices are encouraged but optional.)


Index Terms—At least four keywords or phrases in alphabetical order, separated by commas. 


Note: There should no nonstandard abbreviations, acknowledgments of support, references or footnotes in in the abstract. 



INTRODUCTION[footnoteRef:1] [1:  This paragraph of the first footnote will contain the date on which you submitted your paper for review. It will also contain support information, including sponsor and financial support acknowledgment. For example, “This work was supported in part by the U.S. Department of Commerce under Grant BS123456”. 
The next few paragraphs should contain the authors’ current affiliations, including current address and e-mail. For example, F. A. Author is with the National Institute of Standards and Technology, Boulder, CO 80305 USA (e-mail: author@ boulder.nist.gov). 
S. B. Author, Jr., was with Rice University, Houston, TX 77005 USA. He is now with the Department of Physics, Colorado State University, Fort Collins, CO 80523 USA (e-mail: author@lamar.colostate.edu).
T. C. Author is with the Electrical Engineering Department, University of Colorado, Boulder, CO 80309 USA, on leave from the National Research Institute for Metals, Tsukuba, Japan (e-mail: author@nrim.go.jp).] 

T
[bookmark: _GoBack]HIS document is a template for Microsoft Word versions 6.0 or later. If you are reading a paper or PDF version of this document, please download the electronic file from the AEEESJ Web site at http://www.aeeesj.com/aseeesj_template.docx  so you can use it to prepare your manuscript. 
When you open the template, select “Page Layout” from the “View” menu in the menu bar 
which allows you to see the footnotes. Then, type over sections of the template or cut and paste from another document and use markup styles. The pull-down style menu is at the left of the Formatting Toolbar at the top of your Word window (for example, the style at this point in the document is “Text”). Highlight a section that you want to designate with a certain style, then select the appropriate name on the style menu. The style will adjust your fonts and line spacing. Do not change the font sizes or line spacing to squeeze more text into a limited number of pages. Use italics for emphasis; do not underline. 
To insert images in Word, position the cursor at the insertion point and either use Insert | Picture | From File or copy the image to the Windows clipboard and then Edit | Paste Special | Picture (with “float over text” unchecked). 


Procedures For Paper Submission
Review Stage
Please check with your editor on whether to submit your manuscript as hard copy or electronically for review. If hard copy, submit photocopies such that only one column appears per page. This will give your referees plenty of room to write comments. Send the number of copies specified by your editor (typically four). If submitted electronically, find out if your editor prefers submissions on disk or as e-mail attachments.
If you want to submit your file with one column electronically, please do the following:
	--First, click on the View menu and choose Print Layout.
	--Second, place your cursor in the first paragraph. Go to the Format menu, choose Columns, choose one column Layout, and choose “apply to whole document” from the dropdown menu.
	--Third, click and drag the right margin bar to just over 4 inches in width.
The graphics will stay in the “second” column, but you can drag them to the first column. Make the graphic wider to push out any text that may try to fill in next to the graphic.
Final Stage
When you submit your final version (after your paper has been accepted), print it in two-column format, including figures and tables. You must also send your final manuscript on a disk, via e-mail, or through a Web manuscript submission system as directed by the society contact. You may use Zip or CD-ROM disks for large files, or compress files using Compress, Pkzip, Stuffit, or Gzip. 
Also, send a sheet of paper or PDF with complete contact information for all authors. Include full mailing addresses, telephone numbers, fax numbers, and e-mail addresses. This information will be used to send each author a complimentary copy of the journal in which the paper appears. In addition, designate one author as the “corresponding author.” This is the author to whom proofs of the paper will be sent. Proofs are sent to the corresponding author only.
Figures
Format and save your graphic images using a suitable graphics processing program that will allow you to create the images as PostScript (PS), Encapsulated PostScript (EPS), or Tagged Image File Format (TIFF), sizes them, and adjusts the resolution settings. If you created your source files in one of the following you will be able to submit the graphics without converting to a PS, EPS, or TIFF file: Microsoft Word, Microsoft PowerPoint, Microsoft Excel, or Portable Document Format (PDF). 

Electronic Image Files (Optional)
 Import your source files in one of the following: Microsoft Word, Microsoft PowerPoint, Microsoft Excel, or Portable Document Format (PDF); you will be able to submit the graphics without converting to a PS, EPS, or TIFF files. Image quality is very important to how yours graphics will reproduce. Even though we can accept graphics in many formats, we cannot improve your graphics if they are poor quality when we receive them. If your graphic looks low in quality on your printer or monitor, please keep in mind that cannot improve the quality after submission.
If you are importing your graphics into this Word template, please use the following steps:
Under the option EDIT select PASTE SPECIAL. A dialog box will open, select paste picture, then click OK. Your figure should now be in the Word Document.
If you are preparing images in TIFF, EPS, or PS format, note the following. High-contrast line figures and tables should be prepared with 600 dpi resolution and saved with no compression, 1 bit per pixel (monochrome), with file names in the form of “fig3.tif” or “table1.tif.” 
Photographs and grayscale figures should be prepared with 300 dpi resolution and saved with no compression, 8 bits per pixel (grayscale). 


Sizing of Graphics
Most charts graphs and tables are one column wide (3 1/2 inches or 21 picas) or two-column width (7 1/16 inches, 43 picas wide). We recommend that you avoid sizing figures less than one column wide, as extreme enlargements may distort your images and result in poor reproduction. Therefore, it is better if the image is slightly larger, as a minor reduction in size should not have an adverse affect the quality of the image. 

Size of Author Photographs
The final printed size of an author photograph is exactly
1 inch wide by 1 1/4 inches long (6 picas × 7 1/2 picas). Please ensure that the author photographs you submit are proportioned similarly. If the author’s photograph does not appear at the end of the paper, then please size it so that it is proportional to the standard size of 1 9/16 inches wide by
2 inches long (9 1/2 picas × 12 picas). JPEG files are only accepted for author photos.

How to create a PostScript File 
First, download a PostScript printer driver from http://www.adobe.com/support/downloads/pdrvwin.htm (for Windows) or from http://www.adobe.com/support/downloads/ pdrvmac.htm (for Macintosh) and install the “Generic PostScript Printer” definition. In Word, paste your figure into a new document. Print to a file using the PostScript printer driver. File names should be of the form “fig5.ps.” Use Open Type fonts when creating your figures, if possible. A listing of the acceptable fonts are as follows: Open Type Fonts: Times Roman, Helvetica, Helvetica Narrow, Courier, Symbol, Palatino, Avant Garde, Bookman, Zapf Chancery, Zapf Dingbats, and New Century Schoolbook.

Print Color Graphics Requirements
AEEESJ accepts color graphics in the following formats: EPS, PS, TIFF, Word, PowerPoint, Excel, and PDF. The resolution of a RGB color TIFF file should be 400 dpi. 
When sending color graphics, please supply a high quality hard copy or PDF proof of each image. If we cannot achieve a satisfactory color match using the electronic version of your files, we will have your hard copy scanned. Any of the files types you provide will be converted to RGB color EPS files. 

Web Color Graphics
AEEESJ accepts color graphics in the following formats: EPS, PS, TIFF, Word, PowerPoint, Excel, and PDF. The resolution of a RGB color TIFF file should be at least 400 dpi. 
Your color graphic will be converted to grayscale if no separate grayscale file is provided. If a graphic is to appear in print as black and white, it should be saved and submitted as a black and white file. 

Graphics Checker Tool
The AEEESJ Graphics Checker Tool enables users to check graphic files. The tool will check journal article graphic files against a set of rules for compliance with AEEESJ requirements.  These requirements are designed to ensure sufficient image quality so they will look acceptable in print.  After receiving a graphic or a set of graphics, the tool will check the files against a set of rules.  A report will then be e-mailed listing each graphic and whether it met or failed to meet the requirements. If the file fails, a description of why and instructions on how to correct the problem will be sent. 
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Fig. 1.  Magnetization as a function of applied field. Note that “Fig.” is abbreviated. There is a period after the figure number, followed by two spaces. It is good practice to explain the significance of the figure in the caption.
 
TABLE I
Units for Magnetic Properties
Symbol
Quantity
Conversion from Gaussian and
CGS EMU to SI a

magnetic flux
1 Mx  108 Wb = 108 V·s
B
magnetic flux density, 
  magnetic induction
1 G  104 T = 104 Wb/m2
H
magnetic field strength
1 Oe  103/(4) A/m
m
magnetic moment
1 erg/G = 1 emu 
   103 A·m2 = 103 J/T
M
magnetization
1 erg/(G·cm3) = 1 emu/cm3
   103 A/m
4M
magnetization
1 G  103/(4) A/m

specific magnetization
1 erg/(G·g) = 1 emu/g  1 A·m2/kg
j
magnetic dipole 
  moment
1 erg/G = 1 emu 
   4  1010 Wb·m
J
magnetic polarization
1 erg/(G·cm3) = 1 emu/cm3
   4  104 T
, 
susceptibility
1  4

mass susceptibility
1 cm3/g  4  103 m3/kg

permeability
1  4  107 H/m 
  = 4  107 Wb/(A·m)
r
relative permeability
  r
w, W
energy density
1 erg/cm3  101 J/m3
N, D
demagnetizing factor
1  1/(4)
Vertical lines are optional in tables. Statements that serve as captions for the entire table do not need footnote letters. 
aGaussian units are the same as cgs emu for magnetostatics; Mx = maxwell, G = gauss, Oe = oersted; Wb = weber, V = volt, s = second, T = tesla, m = meter, A = ampere, J = joule, kg = kilogram, H = henry.



An AEEESJ copyright form should accompany your final submission. You can get a .pdf, .html, or .doc version at http://www.aeeesj.com/authors-guide/copyright-policy/ . Authors are responsible for obtaining any security clearances.

MATH
If you are using Word, use either the Microsoft Equation Editor or the MathType add-on (http://www.mathtype.com) for equations in your paper (Insert | Object | Create New | Microsoft Equation or MathType Equation). “Float over text” should not be selected. 

Units
Use either SI (MKS) or CGS as primary units. (SI units are strongly encouraged.) English units may be used as secondary units (in parentheses). This applies to papers in data storage. For example, write “15 Gb/cm2 (100 Gb/in2).” An exception is when English units are used as identifiers in trade, such as “3½-in disk drive.” Avoid combining SI and CGS units, such as current in amperes and magnetic field in oersteds. This often leads to confusion because equations do not balance dimensionally. If you must use mixed units, clearly state the units for each quantity in an equation.
The SI unit for magnetic field strength H is A/m. However, if you wish to use units of T, either refer to magnetic flux density B or magnetic field strength symbolized as µ0H. Use the center dot to separate compound units, e.g., “A·m2.”

Helpful Hints
Figures and Tables
Because AEEESJ will do the final formatting of your paper, you do not need to position figures and tables at the top and bottom of each column. Large figures and tables may span both columns. Place figure captions below the figures; place table titles above the tables. If your figure has two parts, include the labels “(a)” and “(b)” as part of the artwork. Please verify that the figures and tables you mention in the text actually exist. Please do not include captions as part of the figures. Do not put captions in “text boxes” linked to the figures. Do not put borders around the outside of your figures. Use the abbreviation “Fig.” even at the beginning of a sentence. Do not abbreviate “Table.” Tables are numbered with Roman numerals. 
Figure axis labels are often a source of confusion. Use words rather than symbols. As an example, write the quantity “Magnetization,” or “Magnetization M,” not just “M.” Put units in parentheses. Do not label axes only with units. As in Fig. 1, for example, write “Magnetization (A/m)” or “Magnetization (Am1),” not just “A/m.” Do not label axes with a ratio of quantities and units. For example, write “Temperature (K),” not “Temperature/K.” 
Multipliers can be especially confusing. Write “Magnetization (kA/m)” or “Magnetization (103 A/m).” Do not write “Magnetization (A/m)  1000” because the reader would not know whether the top axis label in Fig. 1 meant 16000 A/m or 0.016 A/m. Figure labels should be legible, approximately 8 to 12 point type.
References
Number citations consecutively in square brackets [1]. The sentence punctuation follows the brackets [2]. Multiple references [2], [3] are each numbered with separate brackets [1]–[3]. When citing a section in a book, please give the relevant page numbers [2]. In sentences, refer simply to the reference number, as in [3]. Do not use “Ref. [3]” or “reference [3]” except at the beginning of a sentence: “Reference [3] shows ... .” Please do not use automatic endnotes in Word, rather, type the reference list at the end of the paper using the “References” style.
Number footnotes separately in superscripts (Insert | Footnote).[footnoteRef:2] Place the actual footnote at the bottom of the column in which it is cited; do not put footnotes in the reference list (endnotes). Use letters for table footnotes (see Table I).  [2: It is recommended that footnotes be avoided (except for the unnumbered footnote with the receipt date on the first page). Instead, try to integrate the footnote information into the text.] 

Please note that the references at the end of this document are in the preferred referencing style. Give all authors’ names; do not use “et al.” unless there are six authors or more. Use a space after authors’ initials. Papers that have not been published should be cited as “unpublished” [4]. Papers that have been accepted for publication, but not yet specified for an issue should be cited as “to be published” [5]. Papers that have been submitted for publication should be cited as “submitted for publication” [6]. Please give affiliations and addresses for private communications [7].
Capitalize only the first word in a paper title, except for proper nouns and element symbols. For papers published in translation journals, please give the English citation first, followed by the original foreign-language citation [8].
Abbreviations and Acronyms
Define abbreviations and acronyms the first time they are used in the text, even after they have already been defined in the abstract. Abbreviations such as AEEESJ, SI, ac, and dc do not have to be defined. Abbreviations that incorporate periods should not have spaces: write “C.N.R.S.,” not “C. N. R. S.” Do not use abbreviations in the title unless they are unavoidable (for example, “AEEESJ” in the title of this article).
Equations
Number equations consecutively with equation numbers in parentheses flush with the right margin, as in (1). First use the equation editor to create the equation. Then select the “Equation” markup style. Press the tab key and write the equation number in parentheses. To make your equations more compact, you may use the solidus ( / ), the exp function, or appropriate exponents. Use parentheses to avoid ambiguities in denominators. Punctuate equations when they are part of a sentence, as in

	(1)

Be sure that the symbols in your equation have been defined before the equation appears or immediately following. Italicize symbols (T might refer to temperature, but T is the unit tesla). Refer to “(1),” not “Eq. (1)” or “equation (1),” except at the beginning of a sentence: “Equation (1) is ... .”
Other Recommendations
Use one space after periods and colons. Hyphenate complex modifiers: “zero-field-cooled magnetization.” Avoid dangling participles, such as, “Using (1), the potential was calculated.” [It is not clear who or what used (1).] Write instead, “The potential was calculated by using (1),” or “Using (1), we calculated the potential.”
Use a zero before decimal points: “0.25,” not “.25.” Use “cm3,” not “cc.” Indicate sample dimensions as “0.1 cm  0.2 cm,” not “0.1  0.2 cm2.” The abbreviation for “seconds” is “s,” not “sec.” Do not mix complete spellings and abbreviations of units: use “Wb/m2” or “webers per square meter,” not “webers/m2.” When expressing a range of values, write “7 to 9” or “7-9,” not “7~9.”
A parenthetical statement at the end of a sentence is punctuated outside of the closing parenthesis (like this). (A parenthetical sentence is punctuated within the parentheses.) In American English, periods and commas are within quotation marks, like “this period.” Other punctuation is “outside”! Avoid contractions; for example, write “do not” instead of “don’t.” The serial comma is preferred: “A, B, and C” instead of “A, B and C.”
If you wish, you may write in the first person singular or plural and use the active voice (“I observed that ...” or “We observed that ...” instead of “It was observed that ...”). Remember to check spelling. If your native language is not English, please get a native English-speaking colleague to carefully proofread your paper.
Some Common Mistakes
The word “data” is plural, not singular. The subscript for the permeability of vacuum µ0 is zero, not a lowercase letter “o.” The term for residual magnetization is “remanence”; the adjective is “remanent”; do not write “remnance” or “remnant.” Use the word “micrometer” instead of “micron.” A graph within a graph is an “inset,” not an “insert.” The word “alternatively” is preferred to the word “alternately” (unless you really mean something that alternates). Use the word “whereas” instead of “while” (unless you are referring to simultaneous events). Do not use the word “essentially” to mean “approximately” or “effectively.” Do not use the word “issue” as a euphemism for “problem.” When compositions are not specified, separate chemical symbols by en-dashes; for example, “NiMn” indicates the intermetallic compound Ni0.5Mn0.5 whereas “Ni–Mn” indicates an alloy of some composition NixMn1-x.
Be aware of the different meanings of the homophones “affect” (usually a verb) and “effect” (usually a noun), “complement” and “compliment,” “discreet” and “discrete,” “principal” (e.g., “principal investigator”) and “principle” (e.g., “principle of measurement”). Do not confuse “imply” and “infer.” 
Prefixes such as “non,” “sub,” “micro,” “multi,” and “ultra” are not independent words; they should be joined to the words they modify, usually without a hyphen. There is no period after the “et” in the Latin abbreviation “et al.” (it is also italicized). The abbreviation “i.e.,” means “that is,” and the abbreviation “e.g.,” means “for example” (these abbreviations are not italicized).

Editorial Policy
Submission of a manuscript is not required for participation in a conference. Do not submit a reworked version of a paper you have submitted or published elsewhere. Do not publish “preliminary” data or results. The submitting author is responsible for obtaining agreement of all coauthors and any consent required from sponsors before submitting a paper. AEEESJ Journal strongly discourages courtesy authorship. It is the obligation of the authors to cite relevant prior work.

Publication Principles
The contents of AEEESJ Journal are peer-reviewed and archival. 
Authors should consider the following points:
1) Technical papers submitted for publication must advance the state of knowledge and must cite relevant prior work. 
2) The length of a submitted paper should be commensurate with the importance, or appropriate to the complexity, of the work. For example, an obvious extension of previously published work might not be appropriate for publication or might be adequately treated in just a few pages.
3) Authors must convince both peer reviewers and the editors of the scientific and technical merit of a paper; the standards of proof are higher when extraordinary or unexpected results are reported. 
4) Because replication is required for scientific progress, papers submitted for publication must provide sufficient information to allow readers to perform similar experiments or calculations and use the reported results. Although not everything need be disclosed, a paper must contain new, useable, and fully described information. For example, a specimen’s chemical composition need not be reported if the main purpose of a paper is to introduce a new measurement technique. Authors should expect to be challenged by reviewers if the results are not supported by adequate data and critical details.
5) Papers that describe ongoing work or announce the latest technical achievement, which are suitable for presentation at a professional conference, may not be appropriate for publication in AEEESJ JOURNAL.

Conclusion
Please include a brief summary of the possible clinical implications of your work in the conclusion section. Although a conclusion may review the main points of the paper, do not replicate the abstract as the conclusion. Consider elaborating on the translational importance of the work or suggest applications and extensions. 
Appendix
Appendixes, if needed, appear before the acknowledgment.
Acknowledgment
The preferred spelling of the word “acknowledgment” in American English is without an “e” after the “g.” Use the singular heading even if you have many acknowledgments. Avoid expressions such as “One of us (S.B.A.) would like to thank ... .” Instead, write “F. A. Author thanks ... .” Sponsor and financial support acknowledgments are placed in the unnumbered footnote on the first page, not here.
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  Abstract   (The   abstract   should   not   exceed   250   words.   It   should   briefly   summarize   the   essen ce   of   the   paper   and   address   the   following   areas   without   using   specific   subsection   titles . ):   Objective :   B riefly   state   the   problem   or   issue   addressed ,   in   language   accessible   to   a   general   s cientific   audience.   Technology   or   Method:   Brief l y   summarize   the   techno logical   innovation   or   method   used   to   address   the   problem .   Results:   Provide   a   brief   summary   of   the   results   and   fi ndings .   Conclusions:   Give   brief   concluding   remarks   on   your   outcomes.   Clinical   Impact:   Comment   on   the   translational   aspect   of   the   work   presented   in   the   paper   and   its   potential   clinical   impact.   Detailed   discussion   of   these   aspects   should   be   provide d   in   the   main   body   of   the   paper.       (Note   that   the   organization   of   the   body   of   the   paper   is   at   the   authors’   discre tion;   the   only   required   sections   are   I ntr oduction,   M ethods   and   Procedures,   R esults,   Conclusion,   and   R eferences.   Acknowledgements   and   Appendices   are   encouraged   but   optional.)       Index Terms — At least four keywords or phrases in alphabetical order, separated by commas.        Note:   There   should   no   nonstandard   abbreviations,   acknowledgments   of   support,   references   or   footnotes   in   in   the   abstract.         I.   I NTRODUCTION
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  HIS   document is a template for Microsoft  Word   versions 6.0 or later. If you are reading a paper  or PDF  version of this document, pleas e download the electr onic  file  from   the  AEEESJ   Web site at   http://www. aeeesj.com/aseeesj_template.docx     so you can use it  to prepare your manuscript.    When you ope n  the template , select “Page Layout” from  the “Vie w” menu in the menu bar    which allows you to see the footnotes. Then, type over  sections of  the template   or cut and paste from another  document and use markup styles. The pull - down style menu   
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  This paragraph of the first footnote will contain the date on which you  submitted your paper for review. It will also contain support information,  including sponsor and financial support acknowledgment. For exa mple,  “This work was supported in part by the U.S. Depart ment of Com merce  under Grant BS123456”.    The next few paragraphs should contain the authors’ current  affiliations, including current address and e - mail. For example, F. A.  Author is with the Nation al Institute of Standards and Technology,  Boulder, CO 80305 USA (e - mail: author@ boulder.nist.gov).    S. B. Author, Jr., was with Rice University, Houston, TX 77005 USA.  He is now with the Department of Physics, Colorado State University, Fort  Collins, CO 8 0523 USA (e - mail: author@lamar.colostate.edu).   T. C. Author is with the Electrical Engineering Department, University  of Colorado, Boulder, CO 80309 USA, on leave from the National  Research Institute for Metals, Tsukuba, Japan (e - mail:  author@nrim.go.jp).   is at the left   of the Formatting Toolbar at the top of your  Word   window (for example, the style at this point in the  document is “Text”). Highlight a section that you want to  designate with a certain style, then select the appropriate  name on the style menu. The style w ill adjust your fonts  and line spacing.  Do not change the font sizes or line  spacing to squeeze more text into a limited number of  pages.  Use italics for emphasis; do not underline.    To insert images in  Word,   position the cursor at the  insertion point and  either use Insert | Picture | From File or  copy the image to the Windows clipboard and then Edit |  Paste Special | Picture (with “float over text” unchecked).        II.   P ROCEDURES  F OR  P APER  S UBMISSION   A.   Review Stage   Please check with your editor on whether to submit your  manuscript as hard copy or electronically for review. If hard  copy, submit photocopies such that only one column  appears per page. This will give your referees plenty of  room to write comments. Send the number of copies  specified by your editor (typically four). If submitted  electronically, find out if your editor prefers submissions on  disk or as e - mail attachments.   If you want to submit your file with one column  electronically, please do the following:  
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